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1. INTRODUCTION

This manual explains how to perform an uplink recording with a DRFA912 device and how to convert this 
recording into a pulse file which can be used to extract an HPD diagram using the RASS-S HPD Uplink 
software.

2. PERFORMING THE UPLINK RECORDING

2.1. Measurement Principle
The Uplink measurement will provide you with horizontal polar diagrams of any (M)SSR/PSR antenna in its 
operational environment by recording the Tx pulses of the radar. For this purpose the DRFA912 is set-up in 
the field with no connection to the radar. An antenna will pick up the radar signal from the air (P1-P2-P3 
1030MHz or PSR transmissions) and the DRFA Scope software will perform the recording and save the 
pulses to the harddisk of your computer.

The detailed pulse shape is recorded and after the recording the DRFA912 Uplink Convertor plug-in can be 
used to read the recorded file and convert it into a pulse file that can be analysed using the RASS-S HPD 
Uplink software.

When selecting a measurement position for the uplink equipment, take into account the following guidelines:

• Make sure to have direct line of sight to the radar under test and select a location at a distance of 
min. 0.5km and max. 40km. 

• Place the antenna at least 1.5m above ground level, preferably even higher. If the radar station 
remains visible, even when standing behind the antenna, a good measurement result may be 
expected. 

• Choose the correct antenna polarization. All SSRs are vertically polarized. Primary radars can be 
vertical (most common), horizontal or circular.

• It is advisable to record the antenna signals in both polarization modes. That way, whatever the 
mode used, or expected, the data is never lost. At the same time the cross polarization is measured, 
including the effect of the environment. Usually the effect of a high cross polarization is caused by 
reflections. Therefore it can be used to determine bad positioning of the measuring antenna for 
reference measurements.

• Beware of nearby buildings or other structures reflecting large portions of the signal. These 
reflections may influence your measurement. 

• The most frequent error is a measurement from a too low elevation angle. The HPD diagram is still 
correct but doesn’t represent the view of the targets and antenna. If in doubt, use an inclinometer to 
find the elevation angle from the measurement position towards the radar under test.

• Depending on the distance of the uplink setup to the radar system, extra attenuation must be 
inserted at the Rx input. As a general rule it is best to start with 20dB (SSR) or 40dB attenuation 
(PSR) or even more.

• If an uplink measurement shows any abnormality/anomaly of the beam pattern, it is recommended 
that additional uplink measurements are taken from 2 different location, ideally separated 120 
degrees apart around the radar. The abnormality/anomaly may be due to an antenna fault or the 
environment. If the abnormality/anomaly is at the same location within the beam pattern from all 
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locations, the problem is caused by the antenna. If the abnormality/anomaly moves within the beam 
pattern between the 3 locations, the abnormality/anomaly is caused by the environment e.g. lightning 
pole.

Check-out the Uplink connection diagram leaflet delivered with the DRFA912 for the correct 
connections and set-up. This connection diagram can also be loaded through the Help menu of the 
DRFA912 software. A Tutorial explaining how to use the DRFA912 together with a DTI529 (Didactical  
Test Interrogator) to practice the uplink measurement can also be found in the Help menu.
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2.2. Using the DRFA912 Software
The DRFA912 Scope software can be started from the RASS-M Toolbox or the Windows Start menu.

 DRFA912 Scope button

The DRF912 Scope software will load, showing:
• the menu bar
• the toolbar
• the scope display and related settings, 
• the DRFA controls and settings, 
• a comment field 
• the status bar
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Figure 1: DRFA912 Scope GUI



DRFA912 Uplink Manual Edition Date: 08-Dec-14

The DRFA912 scope can operate in two different modes:
• Live mode: In this mode the software is used to control the DRFA912 and the scope display gives a 

live view of the signal available at the selected input of the DRFA912 according to the settings used.
• File mode: This mode is automatically entered when loading a recording. The controls section will 

change into a file control section. In this mode the uplink conversion plug-in can be used to 
extract the pulses for the antenna diagram.

The DRFA Scope software always starts in Live mode and checks if a DRFA912 can be detected. If the 
DRFA912 is not connected yet or is not powered on, the status bar will indicate 'no device'.

Once the DRFA912 is detected, it will be initialized with the default settings as loaded by the software at 
start-up. The device and its serial number are indicated in the status bar.

In Live mode the following toolbar buttons are important:

 Live Capture: starts displaying video and data. This button also switches from file mode (viewing 

recordings) to live mode. 
At start the Live Capture button is automatically selected and disabled indicating that the DRFA912 
is running.

 Pause display / Force trigger: the display stops updating after clicking this button. Clicking it again 

forces a trigger. Click the Live Capture button to switch back to live mode.
Please note that the Pause button only stops the display update. When a recording is in progress, 
the recording will continue.

2.2.1. Performing an Uplink recording

Step 1: Set display mode

For the purpose of recording an antenna diagram it is best to set the display to Log mode. In that case the 
log amplitude of the received signal is displayed vs time.
To do this, click the Display Mode selector in the Display Properties section at the right of the display and 
set it to Log. 

Step 2: Verify settings

Before starting a recording it is necessary to adjust the settings according to the signal connected. 

Input select

• Channel: Select the channel that the measurement antenna is connected to (Rf CH1 or CH2).

• Frequency [MHz]: For SSR the Rx frequency should be 1030MHz, for PSR this should be the PSR 
frequency of the radar.

Mode

• IQ Offset: It is recommended to set this to Auto. In that case the zero level offset of the I and Q 
channel are automatically calculated.
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Timebase

• Sample Frequency[MHz]: More samples means more data (64MHz or 32MHz is OK). 

• Span: Should be enough to hold all pulses in the window.

Trigger

• Trigger Source: For Uplink measurements always use An-pretrigger. This selects triggering to 
occur on the selected input channel.

• PreTrigger [µs]: User choice (make sure all pulses are visible). It depends on the sample rate. For 
SSR it is best to have a pretrigger larger than 2 µs. In that case when triggering on a P2 pulse, also 
P1 is captured in the same span.

• Holdoff Time [µs]: Defines the time before a new trigger can occur. For antenna measurement 
purposes it can be kept at 0.

• Stretch Length: Defines how much data should be captured after a trigger.

Depending on the selected sample frequency and the selected trigger level, the data load is calculated. 
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Since the DRFA912 is connected to the computer using USB 2.0, it is required to keep the data load below 
40MB/s. Data load is indicated in the status bar at the right side. When data overflow occurs, it is indicated in 
the Info window. Data overflow mostly happens when the trigger level is set too low.

Step 3: Set trigger level

At the left of the display a slider is available that can be used to set the trigger level. Its scale is always the 
same as the Y-scale of the signal display. Position the trigger level such that all pulses are detected properly, 
but no false triggers occur due to the noise. If the trigger level is too low; only noise will be sampled. 

Step 4: Select folder

If the settings give results that are satisfying, please click the Select folder button to select a specific 
folder to store the recording.  A window will pop-up asking to select a folder. If required first create a new 
recording folder then select the wanted destination folder. The DRFA scope status bar will show the selected 
folder name.
Caution: When the selected folder is not empty, previous recordings will be overwritten. A message 
will inform the user when the selected folder is not empty!

Step 5: Record data

You can use the Comment field to include information about the recording in the recording directory 
(information like measurement place, attenuation used, polarisation of measurement antenna,...).

After selecting a folder, use the Record button to begin writing to disk. A progress bar will indicate 
recording progress. 

Step 6: Stop recording

The DRFA software stops recording when you click the Stop button or when the maximum recording 
size is reached. For uplink recordings it is strongly advised to record minimal 3 scans due to the reason that 
the HPD extraction algorithm (within RFA RASS-S tools) requires minimal 3 full scans to successfully extract 
a HPD diagram from the recorded pulses. The recording is automatically saved to the selected folder when 
the Stop button is hit or when the maximum recording size is reached. 

The user also has the option to export the data to a tab separated file format. Set the vertical M1 (green) and 
M2 (blue) marker to select the data which you wish to export. The data between markers M1 and M2 of that 

scan will be exported to a tab separated file when you click the Save to Spreadsheet button. The 
exported file will include 4 columns: absolute timestamp, relative timestamp and the data from the 2 
recording channels.

Use the Snapshot  button to save a snapshot (.jpeg) of the DRFA912 Scope window.
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2.2.2. Viewing the recorded data

Step 7: Load file to view recording

Viewing recorded data can be done using the DRFA Scope software in file mode. When you click the  
Load file button a dialog will be presented to select the folder containing the recording of interest. Click the 
folder of interest and use the Select button to start loading the file.

Loading the file can take a few moments. A pop-up window is shown indicating the progress:

Once loaded, the DRFA Scope will switch to file mode. This can be recognized by the file controls becoming 
visible. The status bar indicates the name of the recording currently being viewed and its size. You can step 

through the different spans by clicking the Forward button or the Backward button or you can 
step through the successive frames by using the File Control slider.
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If these steps are performed in the right order you have now succeeded in recording and saving the uplink 
data, the conversion is the next step.
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3. CONVERTING UPLINK RECORDING

Step 8: Load uplink converter

After creating the recording, a plug-in is used in order to convert the DRFA912 recording to a pulse file with a 
.pls extension. This plug-in (called DRFA912 Uplink Convertor) is launched from the Plugins menu at the top 
of the DRFA912 scope interface:

After launching, the Uplink Convertor tool is displayed:

Step 9: Start converting recorded data

The only thing the user is required to do is to click the Start button to convert the recorded data to 
pulses. The software itself will run through the complete file and will calculate and log the amplitude of the 
pulses to a new file with a .pls extension.  A progress bar at the bottom of the interface informs the user how 
far the conversion is accomplished. The more scans are recorded, the longer it takes to convert. There is 
also a software filter included to filter out pulses with a pulse width smaller than 0,25µs and greater than 
10µs.
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Figure 8 shows an example of a conversion in progress. The graph displays the calculated amplitudes of 
each of the pulses detected above threshold setting. A warning is displayed after the conversion is finished 
indicating the file that is saved to disk.

Step 10: Verify antenna diagram

You can now zoom in and analyse the recorded antenna diagram by comparing it for example to a previously 
recorded antenna diagram of the same radar site.

Use the Snapshot  button to save a snapshot of the DRFA912 Uplink Convertor window.
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4. EXTRACTING HPD DIAGRAM

The final step is to extract the HPD diagram using the Extract HPD tool in the Analysis section of the 
toolbox. The program is capable of reading, recognizing and displaying Uplink and Downlink HPD logfiles of 
both (M)SSR and PSR measurements. 

More information on how this is performed can be consulted in the Extract HPD User Manual.
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Figure 10: Zoomed view of the antenna diagram
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